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Abstract. Microplastics (MP) have become a major concern, given the
threat, they pose to marine-derived food and human health. One way to
investigate this threat is to quantify MP found in marine organisms, for
instance making use of image analysis to identify ingested MP in fluores-
cent microscopic images. In this study, we propose a deep learning-based
segmentation model to generate binarized images (masks) that make it
possible to clearly separate MP from other background elements in the
aforementioned type of images. Specifically, we created three variants
of the U-Net model with a ResNet-101 encoder, training these variants
with 99 high-resolution fluorescent images containing MP, each having
a mask that was generated by experts using manual color threshold ad-
justments in ImageJ. To that end, we leveraged a sliding window and
random selection to extract patches from the high-resolution images,
making it possible to adhere to input constraints and to increase the
number of labeled examples. When measuring effectiveness in terms of
accuracy, recall, and F2-score, all segmentation models exhibited low
scores. However, compared to two ImageJ baseline methods, the effec-
tiveness of our segmentation models was better in terms of precision,
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F0.5-score, F1-score, and mIoU: U-Net (1) obtained the highest mIoU of
0.559, U-Net (2) achieved the highest F1-score of 0.682, and U-Net (3)
had the highest precision and F0.5-score of 0.594 and 0.626, respectively,
with our segmentation models, in general, detecting less false positives
in the predicted masks. In addition, U-Net (1), which used binary cross-
entropy loss and stochastic gradient descent, and U-Net (2), which used
dice loss and Adam, were most effective in discriminating MP from other
background elements. Overall, our experimental results suggest that U-
Net (1) and U-Net (2) allow for more effective MP identification and
measurement than the macros currently available in ImageJ.

Keywords: Deep learning · Environmental monitoring · Image segmen-
tation · Microplastics.

1 Introduction

The production of plastics has increased rapidly since the 1940s, mainly due to
the attractive properties of plastic goods (durable, lightweight, corrosion resis-
tant) and inexpensive methods of manufacturing. At present, however, plastics
have become a major environmental concern [4]. Specifically, in the marine envi-
ronment, microplastics or MP (< 5 mm) are currently the most dominant form
of aquatic plastic litter [5], originating from synthetic polymers that are primar-
ily manufactured in small sizes (primary source) or from the degradation of large
plastic fragments (secondary source) [25].

Due to their small size, MP can be ingested by marine organisms during
feeding, which raises significant concerns regarding the safety of seafood [27].
As such, MP consumption by marine biota is typically investigated by extract-
ing and isolating MP through filtration. Using a microscope, particles are then
manually sorted and counted, often requiring the involvement of more than one
researcher to avoid bias in the measurements. Since this method is labor inten-
sive and time consuming, the MP-VAT (microplastics visual analysis tool) macro
in ImageJ [24] was developed in 2019. With MP-VAT, the quantity, size, and
shape of MP can be automatically and rapidly measured [18, 19].

Despite the increased throughput enabled by MP-VAT, this macro is prone to
errors caused by background fluorescence and fluorescence halos from very bright
particles [19]. In this context, additional corrections have to be made to the image
beforehand (i.e., adjustment of the color threshold). This introduces an extra
manual step in the process that is subjective and also time consuming. Hence,
there is a need for a solution that performs better in terms of MP recognition
and measurement.

In this study, we propose a deep learning-based approach that embeds the
calibration criteria used by researchers, facilitating the automatic measurement
of MP in terms of quantity, size, and shape. Specifically, we created an image
segmentation model using deep neural networks, obtaining training data from
high-resolution microscopic images of fluorescently-dyed MP isolated from clams.
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2 Background

2.1 Measurement of microplastics in seafood using MP-VAT

Plastic litter has been transferred, directly or indirectly, to the marine envi-
ronment due to poor waste disposal and management. Because of this, plastic
debris is now ubiquitous in all areas of the ocean [1]. As such, MP could be
ingested intentionally by marine biota when they are mistakenly seen as plank-
ton or other prey, or accidentally by filter feeding [27]. Bivalves (mussels, clams,
and oysters) are commonly used subjects for MP ingestion research since they
are non-selective feeders, abundant worldwide, and easy to handle [27]. Aside
from these observations, bivalves are usually eaten whole, making them suitable
for the assessment of health risks associated with human consumption of food
contaminated with MP [9].

Through visual sorting and counting using a microscope, MP measurement
was initially performed manually. By making use of fluorescent staining and sub-
sequent image processing in ImageJ, the throughput of MP measurement could
be greatly improved, hereby also reducing bias [11]. Nonetheless, until 2019, im-
age analysis still had to be mainly done manually [8]. With the introduction of
the MP-VAT macro in ImageJ, the size, shape, and quantity of MP could also
be measured automatically [19]. However, a major drawback is the presence of
bright image areas, significantly hampering the effectiveness of MP-VAT. This is-
sue is aggravated when images are taken under a microscope, which is the case in
most laboratories. Indeed, as a result of high magnification, fluorescence halos
and bright areas in the background become more prominent, leading to MP-
VAT producing compromised results. Because of this, additional image editing
is needed and optimal photography settings have to be determined.

To improve MP-VAT, MP-VAT 2.0 [18] was developed. This second macro
eliminates white reflections by subtracting the green from the red channel, which
improves the detection of red fluorescent particles. In addition, the color thresh-
old method changed from maximum entropy to Renyi entropy [23]. However, as
in the previous case, photographic conditions greatly affect the results, making it
necessary to exactly replicate the conditions used by the developers to maximize
the effectiveness of both MP-VAT and MP-VAT 2.0. Since there is limited flexi-
bility in this aspect, there is room for an improved automated MP measurement
approach based on images.

2.2 Image segmentation and deep learning

Image segmentation refers to the process of dividing an image into several mean-
ingful sets of pixels. For example, in everyday life, segmentation is used to divide
the pixels in a personal photograph into human and background pixels, and in
the medical field, segmentation can be used to make a distinction between can-
cerous and non-cancerous pixels in magnetic resonance imaging (MRI) slice. In
general, this is done by finding a threshold that can distinguish between the
region of interest and the background. However, for images containing noise and
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occlusion, various conditions may have to be considered simultaneously. To solve
this problem, many machine learning models have been developed [17]. Given
the recent success of deep neural networks, several deep learning-based models
have been proposed as well [3, 16, 20].

3 Dataset Acquisition

3.1 Wet-lab phase

Sampling Manila clam samples (Ruditapes philippinarum) were bought at the
Incheon Complex Fish Market (Incheon, Korea) in May 2019. Immediately after
the purchase, the samples were kept on ice. After transport to the laboratory,
the clams were wrapped in aluminum foil and stored in a −20 °C freezer.

Extraction (digestion) and purification All steps were performed inside
a clean bench to avoid contamination. Frozen whole clam tissue was separated
from the shell and organic matter was dissolved by incubation in 250 mL 10 %
KOH at 60 °C, applying stirring for 24 hours [6]. Through this digestion step,
the microplastics that were inside the organism were obtained. Once digestion
was completed, samples were vacuum filtered and MP were collected on GF/A
(glass microfiber) filters. To separate MP from marine contaminants (sand and
silt), filter papers were resuspended in 1.37 g/ml Zinc Chloride with sonication.
After three repetitions, the solutions were centrifuged and the supernatant was
filtered to recover MP [14].

Staining Nile Red (1 mg/mL in acetone) was added to the purified sample
solution at a final concentration of 10 µg/ml. The dye was incubated with the
sample at 50 °C for 30 minutes with constant mixing. Solutions were vacuum
filtered using a GF/A filter and excess dye was washed with absolute ethanol
until minimal background fluorescence was achieved [14].

3.2 Dry-lab phase

Capturing and stitching Stained microplastics on filter paper were viewed
under a stereomicroscope (Olympus SZX10) equipped with a fluorescence fil-
ter unit (RFP filter Ex 545-580 nm, Em 610 nm). Because the filter paper was
too large to be captured as a single image, photos were taken by sections (Fig-
ure 1(a)). These sections were combined using Microsoft Image Composite Editor
to create a complete image of the sample.

Binarization Each composite image was loaded in ImageJ. First, the scale was
set (Analyze > Set Scale) and a representative fluorescent particle was selected
to determine the optimal RGB threshold (Image > Adjust > Color threshold)
for the automated selection of microplastics. When necessary, RGB values were
adjusted manually to ensure the selection of all MP. Afterward, a “mask” image
was generated (Edit > Selection > Create mask).
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(a) Original image. (b) Ground truth
mask.

(c) MP-VAT. (d) MP-VAT 2.0.

Fig. 1. (a) A section of the filter paper image with stained MP. In this section, only
the very bright particles are MP and the rest is background. (b) The corresponding
mask image generated by color threshold adjustments and binarization in ImageJ. In
this image, the background noise is removed and only MP are present. (c) The output
of MP-VAT [19]. (d) The output of MP-VAT 2.0 [18].

Counting and measuring The MP-ACT macro [19] was used to automatically
measure the size, shape, and quantity of MP in each mask (Plugins > Macros
> MP-ACT). MP-ACT is an ImageJ macro that functions similar to MP-VAT,
but that allows for manual color thresholding by the user, as opposed to the
maximum entropy thresholding technique of MP-VAT.

4 Methods

As shown in Figure 1(c) and Figure 1(d), a major drawback of using the MP-VAT
macro is the overestimation of MP. To prevent this from happening, researchers
resort to manual color thresholding, as described in Section 3.2, which is time
consuming, subjective, and prone to error. To solve this problem, we propose
a deep learning-based approach that can generate a binarized image (mask)
in a few seconds. This approach automatically learns the expert criteria for
identifying MP using the 99 original images and their corresponding masks.

4.1 Problem definition

Given an image dataset D = (xi, yi)
n
i=1, where xi ∈ Rl×l is a patch extracted

from an original image and where yi ∈ Rl×l is its corresponding mask, letM be
a segmentation model that takes xi as input and that predicts ŷi ∈ Rl×l as an
approximation of the true mask yi:

M(xi; θ) = ŷi ≈ yi , (1)

where θ are the model parameters. The difference between the predicted mask
ŷi and the ground truth mask yi is quantified by a loss function L. Given a
segmentation model M and a loss function L, we want to find the values for θ
that minimize the total loss based on the dataset D. Ideally, when a new patch
xj comes in, the trained model M makes a prediction ŷj that is close to yj .
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4.2 Dataset characteristics

The dataset is composed of 99 original microscopic images, varying in size from
1, 280×960 to 7, 140×5, 424 pixels, annotated with corresponding labels (masks).
Considering the total number of pixels over all masks, 99.985 % of these pixels
are background pixels, whereas 0.015 % of these pixels are MP pixels, pointing
to a substantial imbalance in the type of pixels available. Hence, the original
microscopic images and their corresponding masks were divided into five datasets
in such a way that each dataset comes with a similar total number of MP pixels.
As a result, 19 images were placed in Dataset 1, which was used as the test set,
and 20 images were placed in each of the Datasets 2, 3, 4, and 5, and where the
latter were used as training and validation sets.

Since each input image should come with a fixed size of l× l (see Section 4.1),
which is a common requirement for machine learning methods, the 99 high-
resolution images were cropped into patches with a fixed size of 256×256 pixels,
coming with corresponding masks of the same size. Note that, before calculating
any performance metrics, the original images (each with a predicted mask) need
to be reconstructed from the patches in order to be able to correctly determine
the MP quantity, size, and shape per filter paper image.

Patches are extracted by leveraging a sliding window method, using a step
size of 30 pixels for both the x and y coordinates. A patch is saved if at least one of
its pixels represents MP (as indicated in the corresponding mask). Denoting the
number of patches with MP as N , then dN × 0.05e additional patches without
MP are saved, selecting the coordinates for cropping in a random way. A total
of 157,474 patches were generated after cropping, with each dataset receiving on
average 31, 494.8 (±5, 303.6) patches, of which, on average, 30, 003.8 (±5, 051.8)
contain MP and 1, 491.0 (±251.8) do not contain MP. The number of patches
per dataset ranged from 21, 645 to 36, 508.

Given that the number of patches differed from dataset to dataset, the dif-
ferent datasets were adjusted in order to each have a number of patches equal to
20,000. This adjustment was carried out by random deletion of patches, hereby
keeping the number of patches without MP at approximately 5 % of the number
of patches with MP. Thus, each dataset now consists of 20,000 patches, where,
on average, 19, 084.2 (±13.3) patches contain MP, and 915.8 (±13.3) patches do
not contain MP. Overall, 95.4 % of the 100,000 patches contain MP, while the
remaining 4.6 % does not contain MP.

4.3 Model training

We used U-Net [20], a popular convolutional neural network, as our segmentation
model M. In particular, U-Net is an encoder-decoder model that was initially
developed for medical image segmentation. For our experiments, we chose a U-
Net model with a ResNet-101 [10] encoder, pre-trained on ImageNet [22]. A
high-level Application Programming Interface (API) [28] has been utilized to
build our segmentation model.
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Optimization methods Gradient descent was used to update the parameters
θ of our segmentation model in the negative direction of the gradient of the ob-
jective function ∇θJ(θ), with the goal of minimizing the objective function J(θ),
where J(θ) corresponds to the average loss. Two different optimization methods
were used: (1) Stochastic Gradient Descent (SGD) and (2) Adaptive Moment
Estimation (Adam). For both methods, the model parameters are optimized by
using the objective function obtained over mini batches consisting of 10 patches.

Stochastic Gradient Descent The mathematical form of SGD is, for instance,
described in the technical documentation of PyTorch8. Two hyperparameters of
SGD need to be determined, namely the momentum λ and the learning rate α.
λ allows accelerating the optimization performed by SGD with less fluctuation,
whereas α determines the step size made when updating the parameters in each
iteration [21]. These hyperparameters were set to 0.9 and 0.003, respectively.

Adaptive Moment Estimation When making use of Adam, the learning rate is
computed individually for each parameter. Unlike SGD, which uses gradients
directly, Adam utilizes exponentially moving averages of the gradient and the
squared gradient [13]. The four hyperparameters of Adam, which are the expo-
nential decay rates β1 and β2, the learning rate α, and the constant for numerical
stability ε, were set to their default values: β1 = 0.9, β2 = 0.999, α = 0.001, and
ε = 10−8.

Loss functions Our experiments used the three loss functions discussed below.

Binary cross-entropy (BCE) with logits loss BCE with logits loss is a modifi-
cation of the regular BCE loss function [12], combining the sigmoid activation
function and the BCE loss function into a single layer. The use of BCE with
logits loss is numerically more stable than the use of the sigmoid activation
function and the BCE loss function independently. To mitigate severe class im-
balance, the hyperparameter p can be used to weigh the positive samples. In our
experiments, p was set to 9.

Dice loss The dice coefficient, which is widely used for evaluating the effec-
tiveness of segmentation models [26], is a measure for the overlap between a
predicted and a ground truth segmentation map. This measure can be used as
a loss function which is insensitive to data imbalance [15]. The hyperparameter
ε, which avoids numerical issues when both the prediction and the ground truth
are 0, was set to 1.

BCE with dice loss As discussed in [7], BCE and dice loss can be combined. The
dice loss focuses on the similarity between the prediction and the ground truth
at the image level, whereas the BCE loss focuses on the pixel-wise differences
between the prediction and the ground truth.

8 https://pytorch.org/docs/stable/optim.html
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Model definition We created three different segmentation models, with all
three models using a ResNet-101 encoder pre-trained on ImageNet: U-Net (1)
uses BCE with logits loss and SGD; U-Net (2) uses dice loss and Adam; and
U-Net (3) uses BCE with dice loss and Adam. The effectiveness of the three
aforementioned segmentation models is compared to the effectiveness of the Im-
ageJ macros MP-VAT and MP-VAT 2.0, with the latter two macros acting as
our baselines.

Cross-validation Among the five available datasets, Dataset 1 was set aside
as our test set. Four-fold cross-validation was performed using Datasets 2, 3, 4,
and 5, meaning that in each round, one of the four available datasets was used
as a validation set and the other three formed the training set. For each of the
three segmentation models, four parameter sets were thus obtained. For each
segmentation model, the parameter set that gave the lowest validation loss was
selected as the optimal parameter set, leading to optimal models for U-Net (1),
U-Net (2), and U-Net (3). Using different performance metrics, the effectiveness
of these optimal models was then evaluated and compared to the effectiveness
of the baselines MP-VAT and MP-VAT 2.0.

4.4 Performance metrics

To evaluate the effectiveness of our segmentation models, we used seven metrics:
balanced accuracy, precision, recall, intersection over union (IoU), and three
variations of the Fβ-score (F0.5-, F1-, and F2-score).

Precision =
TP

TP + FP
Balanced Accuracy =

1

2
×

(
TP

TP + FN
+

TN

FP + TN

)
Recall =

TP

TP + FN
IoU =

|A ∩B|
|A ∪B| Fβ-score =

(1 + β2)× (precision× recall)

β2 × precision + recall

Fig. 2. The performance metrics used. TP denotes the number of true positives, TN
the number of true negatives, FP the number of false positives, and FN the number
of false negatives. For IoU, A denotes the number of MP pixels in the ground truth
mask, whereas B denotes the number of MP pixels in the predicted mask. In case of the
Fβ-score, β values of 0.5, 1, and 2 were used to calculate the F0.5-, F1-, and F2-score,
respectively.

Note that all metrics, with the exception of IoU, are calculated using the
average TP , TN , FP , and FN values, as obtained from four-fold cross valida-
tion. In this context, the obtained balanced accuracy value is referred to as the
mean balanced accuracy (mAcc). On a similar note, the average IoU value, as
obtained for the 19 images in the test set, is denoted as mean IoU (mIoU).
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5 Results and Discussion

Our experimental results are summarized in Table 1. Overall, the effectiveness
of MP-VAT 2.0 was found to be low for all performance metrics used. As can
be seen in Figure 1(d), holes are prominently present in the center of several
MP elements. Indeed, MP-VAT 2.0 seems to have removed the highest values in
the image when subtracting both the green and blue channels. As a result, the
center of several MP elements is missing in a mask, making it difficult for these
MP elements to be properly identified.

Table 1. Performance evaluation.

Model mAcc Precision Recall mIoU F0.5-score F1-score F2-score

MP-VAT 0.986 0.431 0.971 0.392 0.485 0.597 0.777
MP-VAT 2.0 0.719 0.002 0.455 0.139 0.003 0.005 0.012

U-Net (1) 0.934 0.505 0.868 0.559 0.551 0.638 0.759
U-Net (2) 0.906 0.587 0.812 0.557 0.622 0.682 0.755
U-Net (3) 0.899 0.594 0.799 0.519 0.626 0.681 0.747

(a) MP-VAT. (b) MP-VAT 2.0. (c) U-Net (1): BCE
with logits loss and
SGD.

(d) U-Net (2): Dice
loss and Adam.

(e) U-Net (3): BCE
with dice loss and
Adam.

Fig. 3. Visual comparison of the segmentation quality obtained for each segmentation
model: black denotes MP that has been correctly predicted (TP ), red denotes predicted
MP that is not MP (FP ), and green denotes MP that has not been predicted (FN).
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MP-VAT, on the other hand, comes with higher effectiveness, achieving an
mAcc of 0.986, a recall of 0.971, and an F2-score of 0.777. As shown in Fig-
ure 1(c), highly fluorescent MP are intact and visible in the mask. However,
similar to MP-VAT 2.0, some areas of the background are also mistaken to be
MP. Because of this, MP-VAT scores are low in terms of mIoU, F0.5-score, F1-
score, and precision. In comparison, all U-Net-based models score higher with
respect to these four metrics. U-Net (1) and U-Net (2) have the best scores for
mIoU and F1-score, respectively. U-Net (3) obtains the best scores for F0.5-score
and precision. The increase in precision using the U-Net-based models greatly
reduces the number of FP s, thereby improving the discrimination between MP
and background. This fact is also observed through the F0.5-score, since all U-
Net-based models obtain higher values than MP-VAT. Within the U-Net-based
models, both U-Net (2) and U-Net (3) show better handling of FPs than U-Net
(1). As illustrated in Figure 3(c), Figure 3(d), and Figure 3(e), the predicted
masks are closer to the ground truth mask. Moreover, the impact of background
fluorescence and fluorescence halos was considerably reduced, as compared to
Figure 3(a) and Figure 3(b).

Based on the values obtained for the different metrics, it is not straightfor-
ward to select which U-Net-based model is most effective. However, U-Net (3)
seems to be the least effective among the different models used, coming with
the lowest mAcc, recall, F2-score, and mIoU. In spite of these low scores, the
generated masks, with an example shown in Figure 3(e), still demonstrate con-
siderable improvement in discriminating MP from other elements in a fluorescent
image.

In summary, our results show that the U-Net-based models are more effective
at predicting MP, compared to MP-VAT and MP-VAT 2.0. Specifically, despite
a lower balanced accuracy and recall, U-Net (1), U-Net (2), and U-Net (3) in-
troduce significant gains in terms of mIoU, F0.5-score, F1-score, and precision.

6 Conclusions and Future Work

Effective and efficient MP identification and measurement in biological samples
remain a challenge. Currently available methods that rely on image processing,
such as MP-VAT and MP-VAT 2.0, come with limited flexibility and are prone to
errors. In this study, we present a deep learning-based segmentation approach for
MP measurement, serving as an alternative to MP-VAT and MP-VAT 2.0. Three
variations of U-Net, all using a pre-trained ResNet-101 encoder, were tested in
terms of generating masks that depict true MP.

Compared to the MP-VAT macros, all U-Net-based models exhibited better
mIoU, F0.5-score, F1-score, and precision values, with the masks generated by
these U-Net-based models containing less false positives. In this context, the
effectiveness of U-Net (1) and U-Net (2) was found to be slightly better than
the effectiveness of U-Net (3). Furthermore, since the U-Net-based models have
a response time of less than two seconds after input of the original image, their
usage is expected to significantly reduce the time and effort required to produce



A Segmentation Model for Microplastics from Clams 11

a mask, which takes 10 to 30 minutes per image in the original process using
MP-VAT, including false MP correction.

In this initial research effort, the models tested were all based on U-Net.
Future approaches will explore the use of other models, for instance paying
attention to local thresholding methods [29]. In terms of deep learning, other
state-of-the-art models such as DeepLabV3 [2] will be considered. Moreover,
the U-Net-based models presented in this study will be further improved by
modifying the model training strategy and enriching the training dataset used.
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Special Research Fund (BOF) of Ghent University (grant no. 01N01718).
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